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Notice

1. Descriptions of circuits, software and other related information in this document are provided only to illustrate the
operation of semiconductor products and application examples. You are fully responsible for the incorporation of these
circuits, software, and information in the design of your equipment. Renesas Electronics assumes no responsibility for
any losses incurred by you or third parties arising from the use of these circuits, software, or information.

2. Renesas Electronics has used reasonable care in preparing the information included in this document, but Renesas
Electronics does not warrant that such information is error free. Renesas Electronics assumes no liability whatsoever
for any damages incurred by you resulting from errors in or omissions from the information included herein.

3. Renesas Electronics does not assume any liability for infringement of patents, copyrights, or other intellectual property
rights of third parties by or arising from the use of Renesas Electronics products or technical information described in
this document. No license, express, implied or otherwise, is granted hereby under any patents, copyrights or other
intellectual property rights of Renesas Electronics or others.

4. You should not alter, modify, copy, or otherwise misappropriate any Renesas Electronics product, whether in whole or
in part. Renesas Electronics assumes no responsibility for any losses incurred by you or third parties arising from such
alteration, modification, copy or otherwise misappropriation of Renesas Electronics product.

5. Renesas Electronics products are classified according to the following two quality grades: “Standard” and “High
Quality”. The recommended applications for each Renesas Electronics product depends on the product’s quality grade,
as indicated below.

“Standard”: Computers; office equipment; communications equipment; test and measurement equipment; audio
and visual equipment; home electronic appliances; machine tools; personal electronic equipment; and industrial
robots etc.

“High Quality”: Transportation equipment (automobiles, trains, ships, etc.); traffic control systems; anti-disaster
systems; anticrime systems; and safety equipment etc.

Renesas Electronics products are neither intended nor authorized for use in products or systems that may pose a
direct threat to human life or bodily injury (artificial life support devices or systems, surgical implantations etc.), or may
cause serious property damages (nuclear reactor control systems, military equipment etc.). You must check the quality
grade of each Renesas Electronics product before using it in a particular application. You may not use any Renesas
Electronics product for any application for which it is not intended. Renesas Electronics shall not be in any way liable
for any damages or losses incurred by you or third parties arising from the use of any Renesas Electronics product for
which the product is not intended by Renesas Electronics.

6. You should use the Renesas Electronics products described in this document within the range specified by Renesas
Electronics, especially with respect to the maximum rating, operating supply voltage range, movement power voltage
range, heat radiation characteristics, installation and other product characteristics. Renesas Electronics shall have no
liability for malfunctions or damages arising out of the use of Renesas Electronics products beyond such specified
ranges.

7. Although Renesas Electronics endeavors to improve the quality and reliability of its products, semiconductor products
have specific characteristics such as the occurrence of failure at a certain rate and malfunctions under certain use
conditions. Further, Renesas Electronics products are not subject to radiation resistance design. Please be sure to
implement safety measures to guard them against the possibility of physical injury, and injury or damage caused by fire
in the event of the failure of a Renesas Electronics product, such as safety design for hardware and software including
but not limited to redundancy, fire control and malfunction prevention, appropriate treatment for aging degradation or
any other appropriate measures. Because the evaluation of microcomputer software alone is very difficult, please
evaluate the safety of the final products or systems manufactured by you.

8. Please contact a Renesas Electronics sales office for details as to environmental matters such as the environmental
compatibility of each Renesas Electronics product. Please use Renesas Electronics products in compliance with all
applicable laws and regulations that regulate the inclusion or use of controlled substances, including without limitation,
the EU RoHS Directive. Renesas Electronics assumes no liability for damages or losses occurring as a result of your
noncompliance with applicable laws and regulations.

9. Renesas Electronics products and technology may not be used for or incorporated into any products or systems whose
manufacture, use, or sale is prohibited under any applicable domestic or foreign laws or regulations. You should not
use Renesas Electronics products or technology described in this document for any purpose relating to military
applications or use by the military, including but not limited to the development of weapons of mass destruction. When
exporting the Renesas Electronics products or technology described in this document, you should comply with the
applicable export control laws and regulations and follow the procedures required by such laws and regulations.

10. Itis the responsibility of the buyer or distributor of Renesas Electronics products, who distributes, disposes of, or
otherwise places the product with a third party, to notify such third party in advance of the contents and conditions set
forth in this document, Renesas Electronics assumes no responsibility for any losses incurred by you or third parties as
a result of unauthorized use of Renesas Electronics products.

11. This document may not be reproduced or duplicated in any form, in whole or in part, without prior written consent of
Renesas Electronics.

12. Please contact a Renesas Electronics sales office if you have any questions regarding the information contained in this
document or Renesas Electronics products, or if you have any other inquiries.

(Note 1) “Renesas Electronics” as used in this document means Renesas Electronics Corporation and also includes its
majority owned subsidiaries.

(Note 2) “Renesas Electronics product(s)” means any product developed or manufactured by or for Renesas Electronics.

(2012.4)




Disclaimer

By using this Renesas Starter Kit (RSK), the user accepts the following terms:

The RSK is not guaranteed to be error free, and the entire risk as to the results and performance of the RSK is
assumed by the User. The RSK is provided by Renesas on an “as is” basis without warranty of any kind whether
express or implied, including but not limited to the implied warranties of satisfactory quality, fitness for a particular
purpose, title and non-infringement of intellectual property rights with regard to the RSK. Renesas expressly
disclaims all such warranties. Renesas or its affiliates shall in no event be liable for any loss of profit, loss of data,
loss of contract, loss of business, damage to reputation or goodwill, any economic loss, any reprogramming or recall
costs (whether the foregoing losses are direct or indirect) nor shall Renesas or its affiliates be liable for any other
direct or indirect special, incidental or consequential damages arising out of or in relation to the use of this RSK, even
if Renesas or its affiliates have been advised of the possibility of such damages.

Precautions

The following precautions should be observed when operating any RSK product:

This Renesas Starter Kit is only intended for use in a laboratory environment under ambient temperature and humidity
conditions. A safe separation distance should be used between this and any sensitive equipment. Its use outside the
laboratory, classroom, study area or similar such area invalidates conformity with the protection requirements of the
Electromagnetic Compatibility Directive and could lead to prosecution.

The product generates, uses, and can radiate radio frequency energy and may cause harmful interference to radio
communications. However, there is no guarantee that interference will not occur in a particular installation. If this
equipment causes harmful interference to radio or television reception, which can be determined by turning the
equipment off or on, you are encouraged to try to correct the interference by one or more of the following measures;

e ensure attached cables do not lie across the equipment

e reorient the receiving antenna

e increase the distance between the equipment and the receiver

e connect the equipment into an outlet on a circuit different from that which the receiver is connected
e power down the equipment when not in use

e consult the dealer or an experienced radio/TV technician for help NOTE: It is recommended that wherever
possible shielded interface cables are used.

The product is potentially susceptible to certain EMC phenomena. To mitigate against them it is recommended that the
following measures be undertaken;

e The user is advised that mobile phones should not be used within 20m of the product when in use.
e The user is advised to take ESD precautions when handling the equipment.

The Renesas Starter Kit does not represent an ideal reference design for an end product and does not fulfil the
regulatory standards for an end product.




How to Use This Manual

1. Purpose and Target Readers

This manual is designed to provide the user with an understanding of how to use Application Leading Tool
(Code Generator) for RX together with the e’ studio IDE to create a working project for the RSK platform. It is
intended for users designing sample code on the RSK platform, using the many different incorporated
peripheral devices.

The manual comprises of step-by-step instructions to generate code and import it into e studio, but does not
intend to be a complete guide to software development on the RSK platform. Further details regarding
operating the RX130 microcontroller may be found in the Hardware Manual and within the provided sample
code.

Particular attention should be paid to the precautionary notes when using the manual. These notes occur within the body
of the text, at the end of each section, and in the Usage Notes section.

The revision history summarizes the locations of revisions and additions. It does not list all revisions. Refer to the text of
the manual for details.

The following documents apply to the RX130 Group. Make sure to refer to the latest versions of these
documents. The newest versions of the documents listed may be obtained from the Renesas Electronics Web
site.

Document Type Description Document Title Document No.

User’s Manual Describes the technical details of the RSK RSKRX130 User’s Manual R20UT3444EG
hardware.

Tutorial Manual Provides a guide to setting up RSK RSKRX130 Tutorial Manual R20UT3448EG

environment, running sample code and
debugging programs.

Quick Start Provides simple instructions to setup the RSKRX130 Quick Start Guide R20UT3449EG
Guide RSK and run the first sample.

Code Generator Provides a guide to code generation in RSKRX130 Code Generator R20UT3450EG
Tutorial the e’ studio IDE. Tutorial Manual

Schematics Full detail circuit schematics of the RSK. RSKRX130 Schematics R20UT3443EG
Hardware Provides technical details of the RX130 RX130 Group Hardware RO1UHO0560EJ

Manual microcontroller. Manual




2. List of Abbreviations and Acronyms

Abbreviation

Full Form

ADC Analog-to-Digital Converter

API Application Programming Interface

bps Bits per second

CMT Compare Match Timer

COM COMmunications port referring to PC serial port

CPU Central Processing Unit

DVvD Digital Versatile Disc

E1/E2 Lite Renesas On-chip Debugging Emulator

GUI Graphical User Interface

IDE Integrated Development Environment

IRQ Interrupt Request

LCD Liquid Crystal Display

LED Light Emitting Diode

LSB Least Significant Bit

LVD Low Voltage Detect

MCU Micro-controller Unit

MSB Most Significant Bit

PC Personal Computer

Pmod™ Thi§ is a Digilent Pmod™ qupatible connector. Pmod™ s registered to Digilent Inc.
Digilent-Pmod_Interface_Specification

PLL Phase-locked Loop

RAM Random Access Memory

ROM Read Only Memory

RSK Renesas Starter Kit

RTC Realtime Clock

SAU Serial Array Unit

SCI Serial Communications Interface

SPI Serial Peripheral Interface

TAU Timer Array Unit

TFT Thin Film Transistor

TPU Timer Pulse Unit

UART Universal Asynchronous Receiver/Transmitter

usB Universal Serial Bus

WDT Watchdog timer

All trademarks and registered trademarks are the property of their respective owners.
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LENESANS

RSKRX130
RENESAS STARTER KIT

R20UT3450EG0100
Rev. 1.00
Nov 30, 2015

1.0verview

1.1  Purpose

This RSK is an evaluation tool for Renesas microcontrollers. This manual describes how to use the e? studio

IDE code generator plug in to create a working project for the RSK platform.

1.2 Features

This RSK provides an evaluation of the following features:
« Project Creation with e’ studio.

« Code Generation using the code generator plug in.
« User circuitry such as switches, LEDs and a potentiometer.

The RSK board contains all the circuitry required for microcontroller operation.

R20UT3450EG0100 Rev. 1.00
Nov 30, 2015 RENESAS

Page 7 of 51



RSKRX130 2. Introduction

2.Introduction

This manual is designed to answer, in tutorial form, how to use the code generator plug in for the RX family
together with the e’ studio IDE to create a working project for the RSK platform. The tutorials help explain the

following:
e Project generation using the e’ studio
e Detailed use of the code generator plug in for e studio
e Integration with custom code
e Building the project e’ studio

The project generator will create a tutorial project with two selectable build configurations:
e ‘HardwareDebug’ is a project built with the debugger support included. Optimisation is set to zero.

e ‘Release’is a project with optimised compile options (level two) and no outputs debugging information
options selected, producing code suitable for release in a product.

These tutorials are designed to show you how to use the RSK and are not intended as a comprehensive introduction to
the e? studio debugger, compiler toolchains or the E2 Lite emulator. Please refer to the relevant user manuals for more

in-depth information.

R20UT3450EG0100 Rev. 1.00 ——
Nov 30, 2015 RENESAS



RSKRX130 3. Project Creation with e’ studio

3.Project Creation with e studio

3.1 Introduction

In this section the user will be guided through the steps required to create a new C project for the RX130 MCU,
ready to generate peripheral driver code using Code Generator. This project generation step is hecessary to
create the MCU-specific source, project and debug files.

3.2 Creating the Project

Start e” studio and select a suitable location for the project workspace

e Start e studio and select a suitable  [ie% Werkspace Launcher =
location for the project workspace. Select a workspace

e studio stores your projects in a folder called a workspace.
Choose a workspace folder to use for this session.

Workspace: | [SENYEIEET - Browse...

[ Use this as the default and do not ask again

QK ] ’ Cancel
e In the Welcome page, click ‘Go to S =
the e2 studio workbench'. @ Wcome 1
RENESAS

Welcome to
e2studio

Overview | Renesas [Tutorals

Get an overview of the featured % Go through Renesas Tutorials
- Renesas Samples What's New
o Try out the Renesas Samples A Find out what Is new

/ j\] First Steps Workbench
N Take your first steps Go to the e studio workbench

e Create a new C project by right-
clicking in the Project Explorer pave
and selecting ‘New -> C Project’ as

L5 Project Explorer &2

shown. Alternatively, use the menu MNew v Project...
item ‘File -> New -> C Project’.
iy Import... & C Project
tny | Export & C++ Project
cEE
&7 Refresh Es 4 Code Generator
9 oOther.. Ctrl+M
R20UT3450EG0100 Rev. 1.00 RENESAS Page 9 of 51

Nov 30, 2015



RSKRX130 3. Project Creation with e’ studio
e Enter the project name le7] C Praject = ==
‘CG_Tutorial. In  ‘Project type:’ C Project
choose ‘Sample  Project. In =

‘Toolchains’ choose ‘Renesas RXC
Toolchain’. Click ‘Next’.

e In the ‘Target Specific Settings’
dialog, select the options as shown
in the screenshot opposite.

e The R5F51305AxFN MCU is found
under RX100 -> RX130 -> RX130 -
80 pin.

e Click ‘Next'.

Create C project of selected type

Project name: | CG_Tutorial|

Use default location

Project type:

Chworkspace\CG_Tutorial Browse...

Create Directory for Project

Toolchains:

4

4

> (== Debug-Only Project
> [= Executable (TAR)

» (= Others

> = Makefile project

== Executable (Renesas)
@ Sample Project

(== Static Library (Renesas)
& Sample Project

KPIT GMUARM-MNOME-EABI Toolchain
KPIT GMURLTE-ELF Toolchain

KPIT GMURX-ELF Toolchain

KPIT GMUSH-ELF Toolchain

Renesas RXC Toolchain

Renesas SHC Toolchain

Show project types and toolchains only if they are supported on the platform

< Back Nea> | [ Finish ||

Cancel

C Project

e2 studio - Project Generation

Select Target Specific Settings

Toolchain Version : ’v2.04.01

Debug Hardware: ’ E2 Lite (RX)

No Image

Data endian : ’Little-endian data

Available

Select Target: R5F51305.AxFN

Select Configurations:

[¥] Hardware Debug
[ Debug using Simulator : Debug using simulator
[V] Release (no debug)

: Debug using hardware

: Project without any debug information

Build cenfigurations will be created in the project only for the selected debug mode
options, however by default the project will be built for the active configuration i.e,
first configuration selected from group. Based on the device selection you made
(RX100) the debug hardware (E2 Lite (RX]) and debug target (R5F513054xFN), debug
configuration will be automatically created for you.

@ <Back | MNed> |[ Finish ][ Cancel
R20UT3450EG0100 Rev. 1.00 RENESAS Page 10 of 51

Nov 30, 2015




RSKRX130

3. Project Creation with e’ studio

e In the ‘Code Generator Settings
dialog, ensure the ‘Use Peripheral
code Generator’ is checked.

e Click ‘Next'.

e In ‘Select Additional CPU Options’
leave everything at default values.

e Click ‘Next'.

|8 € Project
e2 studio - Project Generation
Code Generator and FIT Settings

V| Use Peripheral code Generator

Use FIT module Download FIT modules

= [E]=]

The &2 studic peripheral code generator automatically generates programs (device drivers) for MCU peripheral functions (clocks,
timers, serial interfaces, A/D converters, DMA controllers, etc.) based on settings entered via a graphical user interface (GUI)
Functions are provided as application programming interfaces (APls) and are not limited to initialization of peripheral functions.
Conventionally, the information "CMCU initial settings", "How to define a target board", "File configuration”, "Names of
functions", "Common interface with user application” etc; has in many cases varied by sample code, so changes needed to be
made to sample code when embedding into a user application. With FIT, there are rules for this information, so each sample code
can be embedded into a user application with ease. Also, the peripheral function drivers and middleware which support FIT have a
common interface with user applications. This makes it easy to port user applications when migrating between RX
microcontrollers.

( User Application ]
Middleware
FIT
cG RTOS
Device Dyjiver Device Driver (BSP)
( MCU |
@ <Back || Met> |[ Fmsh |[ Cancel

C Project

e2 studio - Project Generation

Select Additional CPU Options |

Select Additional CPU Options:

Round: ’Nearest ']
Precision of Double: ’Single precision v]
Sign of Char: ’Unsigned v]
Sign of bit Field: [Unsigned -
Allocate from Lower Bit ’Lower bit v]
Width of Divergence of Function: [24 Bit ']

Specify Global Options:
[] Denormalized number allowed as a result

[] Replace from int with short

[] Enum size is made the smallest

[ Pack structures, unions and classes
[ use try, throw and catch of C++

[T] Use dynamic cast and typeid of C++

[] Saves and restores ACC using the interrupt function

® < Back ” Mext = | [ Finish J ’ Cancel

R20UT3450EG0100 Rev. 1.00
Nov 30, 2015

RENESAS

Page 11 of 51



RSKRX130

3. Project Creation with e’ studio

e In the ‘Global Options Settings’ leave
everything at default values.

e Click ‘Next'.

e Inthe ‘Standard Header Files’ dialog,
select C99 for ‘Library
Configuration’. Untick ‘new(EC++)’
and leave all others at defaults.

e Click ‘Next'.

o/ roject "o o
e2 studio - Project Generation —
Global Options Settings
Patch code generation MNene
Fast interrupt vector register: [None 'l
ROM: [None VI
RAM: [None 'l
Address (H): 00000000
Address Register: [None VI
@ <Back |i Ned> ¢ Enish |[ Cancel |
C Project =0 EoH 5
e2 studio - Project Generation —
Standard Header Files
Library configuration: [iC(C33) -
Select Header Files:
runtime : Runtime routines (Checked and disabled by default)
[ ctypeh : Character classification routines
[] math.h : Mathematical/trigonometric operations(double-precision)
[] mathf.h : Mathematical/trigenometric operations{single-precision)
[ stdarg.h : Variable argument functions
stdio.h : Input/Qutput
stdlib.h : General purpose library features
string.h : String handling operations
[T ies(EC++) : Input/Output Streams
[ new(EC++) : Memory allocation and deallocation routines
[] comnplex(EC++) : Complex number operations
|| string(EC++) : String manipulation operations
|} complex.h(C99) @ Performs complex number calculation
[ fenv.h(Cag) : Sets floating peint environment
[Jinttypes.h(C99) : Converts integer type format
[l wehar.h(C39) : Performs wide character
|} wetype.h(C99)  : Performs wide character conversion
Select All || Deselect All
(?:' < Back ][ Next » I [ Finish ] l Cancel

R20UT3450EG0100 Rev. 1.00
Nov 30, 2015

RENESAS
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RSKRX130

. Project Creation with e’ studio

e In the next dialog, untick all check
boxes except ‘I/O Register Definition
Files' as shown opposite. Click
‘Finish’.

e A summary dialog will appear, click
‘OK’ to complete the project
generation.

C Project
e2 studio - Project Generation

Set various Stack Areas and to add additienal Supperting Files

Stack/Heap Configuration
[7] Use User Stack

User's Stack Size: (H) | 100
Interrupt Stack Size: (H) 300

[ 7] Use Heap Memory
Heap Size: (H) 400

Generation of Supporting Files

[¥]1/0 Register Definition Files

[= e

Generate Hardware Setup Function [None

Project generator summary

Project summary for CG_Tutorial

(i) Thefollowing target device settings and files will be

generated.

Lo o]

PROJECT MAME :
PROJECT DIRECTORY :
CPU SERIES :
CPUTYPE:
TOOLCHAIMN MAME :
TOOLCHAIN VERSION :

CG_Tutorial
Chworkspace
RX100

RX¥130
Renesas_RXC
v2.04.01

GEMERATIOM FILES :

Stack File
\srchystacksct.h

Custom Batch file
Y custom.bat

Main Program
YerchCG_Tutorial.c

Setting of B and R sections

m

Ok ] [ Cancel

R20UT3450EG0100 Rev. 1.00
Nov 30, 2015

RENESAS

Page 13 of 51



RSKRX130 4. Code Generation Using the e’ studio plug in

4.Code Generation Using the e? studio plug in

4.1 Introduction

Code Generator is an e studio plug in GUI tool for generating template ‘C’ source code for the RX130. When
using Code Generator, the user is able to configure various MCU features and operating parameters using
intuitive GUI controls, thereby bypassing the need in most cases to refer to sections of the Hardware Manual.

Once the user has configured the project, the ‘Generate Code’ function is used to generate three code
modules for each specific MCU feature selected. These code modules are name ‘r_cg_xxx.h’, ‘r_cg_xxx.c’,
and ‘r_cg_xxx_user.c’, where ‘xxx’ is a three letter acronym for the relevant MCU feature, for example ‘adc’.
Within these code modules, the user is then free to add custom code to meet their specific requirement.
Custom code should be added, whenever possible, in between the following comment delimiters:

/* Start user code for adding. Do not edit comment generated here */
/* End user code. Do not edit comment generated here */

Code Generator will locate these comment delimiters, and preserve any custom code inside the delimiters on
subsequent code generation operations. This is useful if, after adding custom code, the user needs to re-visit
Code Generator to change any MCU operating parameters.

By following the steps detailed in this Tutorial, the user will generate an e” studio project called CG_Tutorial.
The fully completed Tutorial project is contained on the RSK Web Installer
(http://www.renesas.com/rskrx130/install) and may be imported into e” studio by following the steps in the
Quick Start Guide. This Tutorial is intended as a learning exercise for users who wish to use the Code
Generator to generate their own custom projects for e studio.

The CG_Tutorial project uses interrupts for switch inputs, the ADC module, the 8bit Timer, the Compare Match
Timer (CMT), the Serial Communications Interface (SCI) and uses these modules to perform A/D conversion
and display the results via the Virtual COM port to a terminal program and also on the LCD display on the
RSK.

Following a tour of the key user interface features of Code Generator in 84.2, the reader is guided through
each of the peripheral function configuration dialogs in 84.3. In 85, the reader is familiarised with the structure
of the template code, as well as how to add their own code to the user code areas provided by the code
generator.

The Code Generator installer is contained on the RSK Web Installer. This installer must be run before
proceeding to the next section.

4.2 Code Generator Tour

In this section a brief tour of Code Generator is presented. For further details of the Code Generator
paradigm and reference, refer to the Application Leading Tool Common Operations manual.

You can download the latest document from: http://www.renesas.com/applilet

Application Leading Tool is the stand-alone version of Code Generator and this manual is applicable to the
Code Generator.

From the e’ studio menus, select ‘Window -> Open Perspective -> Other. In the ‘Open Perspective’ dialog
shown in Figure 4-1, select ‘Code Generator’ and click ‘OK’.

R20UT3450EG0100 Rev. 1.00 RENESANS Page 14 of 51
Nov 30, 2015
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RSKRX130 4. Code Generation Using the e’ studio plug in

Open Perspective = @

FZC/C++ (default

l75 Resource
£0Team Synchronizing

[ OK l [ Cancel ]

Figure 4-1 Open Perspective Dialog

In the Project Explorer pane, expand the ‘Code Generator’ and ‘Peripheral Functions’ node. The Code
Generator initial view is displayed as illustrated in Figure 4-2.

|E| Code Generator - e2 studio E@
File Edit Navigate Search Project RenesasWiews Run Window Help
il w A T O R - - - T %\‘@UC** %&Debug Quick Access
[ Project Explorer 22 = % ¥ = O | Peripheral Functions 52 [ Code Preview [ Properties ] Generate Coge 2] ¥ = O
4 5 CG_Tutorial ~ [ Clock sefina | Biock diagram =
> %Includes \ICC setting
> src @ 27(V)<VCC<B5(V) @ 24M<VCC<2T (V) ©18(W) cVCC<24(V)

= CG_Tutorial HardwareDebug.launch

=| CG_Tutorial Release.launch Main clock oscillator

custom.bat Operation
4 % Code Generator
. Main clock oscillation source Resonator -
- /7 Pin View E
4 ﬁ; Peripheral Functions Fregquency 16 (MHz)
@ Clock Generator Osci i .
iscillator wait time 8192 cycles ~ 2048

Voltage Detection Circuit v s
Clock Frequency Accuracy Measurt Dscillation stop detection function Disabled -
Low Power Consumption
Interrupt Controller Unit PLL circuit setting
Buses [C] Operation
Data Transfer Controller = Input freg « division ratio x 12

Event Link Controller
I/O Ports
Multi-Functien Timer Pulse Unit 2

Frequency 32 (MHz)
Part Output Enable 2
8-Bit Timer Sub-clock oscillator and RTC (RTCSCLEK) setting
Compare Match Timer [ Operation
Realtime Clock Drive capacity for low CL
Independent Watchdag Timer
Low Power Timer 32768 lkHz)
Serial Communications Interface ) )
C Bus Inferface High speed clock escillstor (HOCO) setiing
Serial Peripheral Interface I Gpesaion
CRC Calculator Frequency az (MHz)
12-Bit A/D Converter S e e -
D/A Converter El Conscle 52 =« BB | ™ ~M~-=08

Comparator B ~  Code Generator Console

< 1 r

CG_Tutorial/Code Generator/Peripheral Functions/Clock Generator

Figure 4-2 Initial View

Code Generator provides GUI features for configuration of MCU sub systems. Once the user has configured
all required MCU sub systems and peripherals, the user can click the ‘Generate Code’ button, resulting in a
fully configured e” studio project that builds and runs without error.

Navigation to the MCU peripheral configuration screens may be performed by double-clicking the required
function in the Code Generator -> Peripheral Function on the left.

It is also possible to see a preview of the code that will be generated for the current peripheral function
settings by double-clicking the required function in the Code Generator -> Code Preview on the left.
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4.3 Code Generation
In the following sub-sections, the reader is guided through the steps to configure the MCU for a simple project
containing interrupts for switch inputs, timers, ADC and a UART.

4.3.1 Clock Generator

Figure 4-3 shows a screenshot of Code Generator with the Clock Generator function open. Click on the
‘Clock setting’ sub tab. Configure the system clocks as shown in the figure. In this tutorial we are using the
on board 8 MHz crystal resonator for our main clock oscillation source and the PLL circuit is in operation. The

PLL output is used as the main system clock and the divisors should be set as shown in Figure 4-3.

fﬁ‘] *Peripheral Functions 52 | [ Code Preview [ Properties

f5]| Generate Code

Clock setting | Block diagram
WCC setting

@ 27 (V) cMCC 255 (V) @ 24 (V) 2VCC <27 (V) @ 1.8(MVMCC <24 (V)
Main clock oscillator

Operation

Main clock oscillation source Resonator

Frequency 8 (MHz)

Oscillator wait time 2192 cycles - 2048 (us)

Oscillation stop detection function Dizabled
PLL circuit setting

Operation

Input frequency division ratic x 12 -

Fregquency multiplication factor x8 -

Frequency 32 (MHz)
Sub-clock oscillator and RTC (RTCSCLEK) setting

Operation

Sub-clock oscillator drive capacity Drive capacity for low CL

Frequency 32768 (kHz)
High speed clock oscillator (HOCO) setting

[] Operation

Freguency 32 (MHz)
Low speed clock oscillater (LOCO) setting

[] Operation

Frequency 4 (MHz)
System clock setting

Clock source PLL circuit

System clock (ICLK) x1 - 32 (MHz)

Peripheral module clock (PCLKE) x1 - 12 (MHz)

Peripheral module clock for ADC (PCLKD) x1 - 32 (MHz)

Flash IF clock (FCLK) x1 - 32 (MHz)
WD T-dedicated low-speed clock oscillator (IWDTLOCO) setting

[7] Operation

Frequency 15 (kHz)
LPT clock (LPTCLK) setting

[] Operation

Clock source Sub-clock oscillator

Frequency x1/2 16.384 (kHz)
CLKOUT pin setting

[] Operation PE3

Clock output source Main clock cscillator

Frequency x1/2 8 (MHz)

Figure 4-3 Clock setting tab

Proceed to the next section on the Interrupt Controller Unit.
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4.3.2 Interrupt Controller Unit

Referring to the RSK schematic, SW1 is connected to IRQ1 (P31) and SW2 is connected to IRQ2 (P32).
SW3 is connected directly to the ADTRGON and will be configured later in 84.3.5. Navigate to the ‘Interrupt
Controller Unit’ node in Code Generator and in the ‘General’ tab, configure these two interrupts as falling edge
triggered as shown in Figure 4-4 below.

£8l *Peripheral Functions 57 | 5 Code Preview £ Device Top View &8l Device List View [T] Properties %%} FIT Configurator '-33.‘ Generate

Fast interrupt setting
|| Fast interrupt

Software interrupt setting
|| Software interrupt

MNMI setting
[] NMI pin interrupt

IRQ0 setting
[[] IRGO

IRQ1 setting
IRQ1

IRQ2 setting
IRQ2

IRQ3 setting
] IRG3

IRQ4 setting
] IRQ4

Interrupt source

Pricrity

Valid edge

Fin

Valid edge

Pin

Valid edge

Pin

Valid edge

Pin

Valid edge

Fin

Valid edge

BSC (BUSERR vect=16)

Level 15 (highest)

Falling

P30

Low level

P31 v

Falling -

P32 -

Falling -

P13

Low level

PE1

Low level

Digital filter

Digital filter

Pricrity

Digital filter

Pricrity

Digital filter

Priority

Digital filter

Pricrity

Digital filter

Priority

Nao filter

N filter

Level 15 (highest)

Nao filter

Level 15 (highest)

No filter

Level 15 (highest)

N filter

Level 15 (highest)

No filter

Level 15 (highest)

Figure 4-4 Interrupt Functions tab

[=]

=

=

{MHz)

(MHz)

(MHz)

(MHz)

(MHz)

(MHz)
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4.3.3 8bit Timer

Navigate to the ‘8bit Timer’ node in Code Generator. TMRO will be used as an interval timer for generation of
accurate delays.

In the ‘General setting’ sub-tab configure TMRO as shown in Figure 4-5.

28l *Peripheral Functions 3% | [ Code Preview 23 Device Top View 23l Device List View [T Properties FLJ

General setting | TMHEIl TMR1 | TMR2 | TMH3|

Function setting

TMRO &-bit count mode -
TMR1 Unused -
TMR2 Unused -
TMR3 Unused -

Figure 4-5 General setting tab
Navigate to the ‘TMRO’ sub-tab configure TMRO as shown in Figure 4-6. This timer is configured to generate
a High priority interrupt every 1ms. We will use this interrupt later in the tutorial to provide an API for
generating high accuracy delays required in our application.

f,jl *Peripheral Functions 52 | 5 Code Preview E,_EJ Device Top Yiew E,_EJ Device List View [] Properties ;'},J FIT Cenfigurator

| General setting || TMRO!| TMR1 | TMR2 | TMR2 |

Count setting
Clock source PCLK024 * 3125 (kHz)
External clock pin TMCID P21
Counter clear Cleared by compare match 4 -
External reset pin TMRIO P20
Compare match A value (TCORA) 1 ms - (Actual value: 0.952)
Compare match B value (TCORB) 1 ms (Actual value: 0.952)
TMOD output setting

[] Enable TMO0 cutput

TMOD pin PB3

Output at compare match A No change

Output at compare match B No change
Interrupt setting

Enable TCORA compare match interrupt (CMIAD)
[] Enable TCORB compare match interrupt (CMIBO)
[] Enable TCNT overflow interrupt (OVI0)

Priority Level 10 -

Figure 4-6 TMRO tab
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4.3.4  Compare Match Timer

Navigate to the ‘Compare Match Timer’ node in Code Generator. CMTO and CMT1 will be used as timers in
de-bouncing of switch interrupts.

In the ‘CMTO sub-tab and configure CMTO as shown in Figure 4-7. This timer is configured to generate a High
priority interrupt after 20ms. This timer is used as our short switch de-bounce timer later in this tutorial.

f,_gl *Peripheral Functions 23 “jf Code Preview f,_gl Device Top View fﬁl Device List View [T] Properties ﬂ_";' FIT Configurator

CMTO | CMTT

Compare match timer operation setting
) Unused @ Used

Count clock setting
©) PCLKIB @ PCLK32 ) PCLKM28 ©) PCLK/R12

Interval value setting

Interval value 20 ms + [Actual value: 20)

Interrupt setting
Enable compare match interrupt (CMI0)

Prigrity Lewvel 10 -

Figure 4-7 CMTO tab

Navigate to the ‘CMT1’ sub-tab and configure CMT1 as shown in Figure 4-8. This timer is configured to
generate a High priority interrupt after 200ms. This timer is used as our long switch de-bounce timer later in
this tutorial.

f,_gl *Peripheral Functions 23 “jf Code Preview f,_gl Device Top View fﬁl Device List View [T] Properties ﬂ_";' FIT Configurator

Compare match timer operation setting

) Unused @ Used
Count clock setting

@) PCLKIB @ PCLKI32 i©) PCLKM28 i@ PCLK/512

Interval value sething

Interval value 200 ms + [Actual value: 200)

Interrupt setting
Enable compare match interrupt (CMIT)

Prionity Level 10 -

Figure 4-8 CMT1 tab
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4.3.5 12-bit A/D Converter

Navigate to the '12-bit A/D Converter’ tab in Code Generator. Refer to the screenshot shown in Figure 4-9 ,
Figure 4-10 and configure the S12ADO0 as shown. We will be using the S12ADO0 in 12-bit one shot mode on
the ANOOQO input, which is connected to the RV1 potentiometer output on the RSK. The conversion start

trigger will be via the pin connected to SW3.

£

_w “Peripheral Functions &I ;_;,( Code Preview f,_‘ﬁ Device Top View f,_‘ﬁ Device List View [ Properties j_‘g FIT Configurator

General setting \afindow A sefting

Window B setting

S12AD operation setting
@) Unused

Operation mode setting
@ Single scan mode

Double trigger mode setting
@ Disable

A/D conversion select
(@) High-speed
Self diagnosis setting

Mode

Voltage used

Disconnection detection assist setting
Charge setting

Period

Group scan pricrity setting
Group A priority

Group B action

AD converted value count setting
@ Addition mode

High-Potential reference voltage select
@ AvCco

Low-Potential reference voltage select
@ AVSS0

‘Window function setting
@ Disable

‘Window A operation setting
@ Disable
‘Window B operation setting
@ Disable
Data storage buffer setting
@ Disable
Analog input channel setting
Convert (Group A)
ANDOD
ANDO1
ANDOZ
ANDO3
ANDDS
ANDOS
ANDDE
ANDOT
AND16
ANDTT
AND18
AND19
AND20
ANDZ1
AND24
AND25
AND26

Temperature sensor output [

i

Internal reference voltage  [7]

() Group scan mode

@ Used

() Continuous scan mode

() Enable

() Low-current

Unused -

Use VREFHD

Group A without pricrity

Mot restarted or continued due to Group A pricrity

() Awerage mode

(©) VREFHD

(©) VREFLO

() Enable

() Enable

() Enable

) Enable

Convert (Group B) Add!dverage AD value

o

Figure 4-9 A/D Converter tab-1
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— Conversion start trigger setting

Conversion start trigger (Group &)

AD conversion start trigger pin
Conversion start trigger (Group B)

Compare match with or input capture from MTUD. TGRA

— Event link contral setting

ADTRGOE pin selection P16 -
- Data regi setting

AD converted value addition count 1-time conversion -

Data placement Right-alignment -

Automatic clearing Disable automatic clearing -
~ ANDOD / Self-di time setting

Input sampling time 3667 (us) (Actual value: 3.656)
- ANDO1 conversion time setting

Input sampling time |3.BBT | (ps) (Actual value: 3.656)
- ANDO2 conversion time setting

Input sampling time |3 BET | (ps) (Actual value: 3 656)
- ANDD2 conversion time setting

Input sampling time |3.EET | (ps) (Actual value: 3.656)
- ANDD4 conversion time setting

Input sampling time |3.BE? | (ps) (Actual value: 3.656)
— ANDDE conversion time setting

Input sampling time |3.BE? | (p=) (Actual value: 3.656)
- ANDDE conversion time setting

Input sampling time |3.BB? | (ps) (Actual value: 3.656)
- ANOO7 conversion time setting

Input sampling time |3.BE? | (ps) (Actual value: 3.656)
- ANDTE-ANDZ21, AND24-AND26 conversion time setting

Input sampling time |3.EET | (ps) (Actual value: 3.656)
- Temperature sensor cutput conversion time setting

Input sampling time |5 | (ps) (Actual value: 5)
- Internal reference veltage conversion time setting

Input sampling time |5 | (us) (Actual value: 5)
— Conversion time setting

Total conversion time (Group A) 5.031 (p=)

Total conversion time (Group B) | (p=)

ELC scan end event generation condition

‘window A/B compaosite condition

On completion of all scans

| S1280WMELC is output when window A comparison conditions are met OR window B comparison conditions are met

(S12ADWUMELC is output in other cases)

— Interrupt setting

Enable AD conversion end interrupt (S124D10)
Priority

Priority

Level 15 (highest)

n end interrupt for group B (GBADI)

| Level 15 (highest)

- |

Figure 4-10 A/D Converter tab-2
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4.3.6 Serial Communications Interface

Navigate to the ‘Serial Communications Interface’ tab in Code Generator, select the SCI6 sub-tab and apply
the settings shown in Figure 4-11. In the RSKRX130 SCI6 is used as an SPI master for the Pmod LCD on the
PMODL1 connector as shown in the schematic.

28l *Peripheral Functions 22 | [f Code Preview 53 Device Top View £ Device List View |

sci1 | scis | SCIE | sciiz |

! General setting | Setting |

Function setting
) Unused
7 Asynchronous mode Transmission
() Asynchronous mode (Multi-processor) Transmission
(7)) Clock synchronous mode Transmission
(") Smart card interface mode Transmission
) Simple IIC bus
@ Simple SPI bus Master transmit cnly -

Pin setting
TXD6 PE1 RXD6& PED
S5DAG PE1 S5CL6 PED
SMOSI6 FE1 - SMISO6 FED

Figure 4-11 SCI6 General Setting tab
Select the SCI6 ‘Setting’ sub-tab and configure the SPI Master as illustrated in Figure 4-12. Make sure the
‘Transfer direction setting’ is set to ‘MSB-first’ and the ‘Bit rate’ is set to 8000000. All other settings remain at
their defaults.

j_’,_g *Peripheral Functions 2 | 3 Code Preview E,_g Device Top View "E,_A Device List View [ Properties E',_H FIT Cenfigurator Fjj Genel

sci1 | scis | SCIE | sciiz |
| General sefting || Setting |

Transfer direction setting

() LSB-first @ MSB-first
Data inversion setting
@ Normal ) Inverted

Transfer rate setting

Transfer clock Internal clock ~ FEBE3 -

Bit rate 2000000

4

(bps) (Actual value: 8000000, Error : 0%)
[ Enable medulation duty correction

SCKE pin function selection Clock output -
Clock setting
Clock delay Clock is not delayed -

[] Enable clock polarity inversion

Data handling setting

Transmit data handling Diata handled in interrupt service routine -

Interrupt setting

TXI&, TEIS pricrity Level 15 (highest) -
Callback function setting
Transmission end
Figure 4-12 SCI6 SPI Master Setting
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Staying in the ‘Serial Communications Interface’ tab in Code Generator, select the SCI1 sub-tab and apply the
settings shown in Figure 4-13. In the RSKRX130 SCI1 is connected via a Renesas RL78/G1C to provide a

USB virtual COM port as shown in the schematic.

scit | scis | scie | sciz |

28 *Peripheral Functions 52 | [ Code Preview 5l Device Top View 53 Device List View [

General setting | Setting |

Function setting
7 Unused

@ Asynchronous mode
() Asynchronous mode (Multi-processor)
) Clock synchronous mode

(7) Smart card interface mode

") Simple 1IC bus

() Simple SPI bus
Fin setting

XD P26

SSDAT P26

SMOSsN P26

Transmission/reception

Transmission

Slave transmitireceive

RXD1 F30
S5CL P15
SMISON F15

Figure 4-13 SCI1 General Setting tab

Select the SCI1 ‘Setting’ sub-tab and configure SCI1 as illustrated in Figure 4-14. Make sure the ‘Start bit
edge detection’ is set as ‘Falling edge on RXD1 pin’ and the ‘Bit rate’ is set to 19200 bps. All other settings
remain at their defaults.
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Eﬂ*Peripheral Functions &3 Ef Code Preview zg Device Top View "E;J Device List View [ Properties Z’g FIT Configurator ‘EJ Genel
SCI | sCI5 | SCI6 | SCh2
| General seﬂ.ingl Setting |

- Start bit edge detection setting

() Low level on RXD1 pin @ Falling edge on RXD1 pin
— Data length setting

() 9 bits @ 8 bits () 7 bits
— Parity setting

@ MNone ©) Even @ Odd
— Stop bit length setting

@ 1bit © 2 bits
~Transfer direction setting

@ LSB-first () MSB-first
~ Transfer rate setting

Transfer clock Internal clock -

Base clock 16 cycles for 1-bit period

Bit rate 13200 - (bps) (Actual value: 19230.763, Error: 0.16%)

[] Enable modulation duty correction
SCK1 pin function SCK1 is not used - P17

—MNoize filter setting
|| Enable noise filter

Moize filter clock Clock =signal divided by 1 32000000 (Hz)
—Hardware flow control setting

@) None ® cTs ® RTS

CTS1/RTS1 pin P14

- Diata handling setting

Transmit data handling Data handled in interrupt service routine -
Receive data handling Data handled in interrupt service routing -
— Interrupt setting

Enable error interrupt (ERIT)
TXI1, RXI1, TEI, ERI pricrity Level 15 (highest) -

— Callback function setting
Transmission end Reception end Reception errar

Figure 4-14 SCI1 Asynchronous Setting
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4.3.7 I/O Ports

Referring to the RSK schematic, LEDO is connected to P21, LED1 is connected to P04, LED2 is connected to
P06 and LED3 is connected to PO7. Navigate to the ‘I/O Ports’ tab in Code Generator and configure these
four 1/O lines as shown in Figure 4-15 and Figure 4-16 below. Ensure that the ‘Output 1’ tick box is checked.
This ensures that the code is generated to set LEDs initially off.

&l *Peripheral Functions 52 | 5 Code Preview & Device Top View &l Device List View [] Properties L FIT Configurator % Genei

| Portd | Port1 | Port2 | Port3 | Port4 | Port5 | Porta | PoriB | PortC | PortD | PoriE | PortH | Ports |

P20

@ Unused @ In
P21

) Unused @ In
P26

@ Unused @ In 2
P27

@ Unused @ In

@) Out

@ Out

@ Out (¥

@) Out

CMOS output

CMOS output

Figure 4-15 1/O ports — Port2

QOutput 1 [T High-drive output

Eil *Peripheral Functions 5 | /o Code Preview £l Device Top View £l Device List View [] Properties ¥L FIT Configurator 5] Gene

Portd | Port1 | Port2 | Port3 | Port4 | Port5 | Porta | PortB | PortC | PortD | PortE | PortH | Ports |

PO3

@ Unused @ In
P04

) Unused @ In
P05

@ Unused @ In
P0G

) Unused @ In
PO7

) Unused @ In

=) Out

@ Out

@ Out

@ Out

@ Out

Figure 4-16 1/O ports — Port0

Output 1

Output 1

Output 1
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P17 is used as one of the LCD control lines, together with PB2, PC2 and PC3. Configure these lines as shown
in Figure 4-17, Figure 4-18 and Figure 4-19 below.

ﬂ *Peripheral Functions &2 E Code Preview ﬂ Device Top View ﬂ Device List View [] Properties zg FIT Configurator ’@J Genel

| Porto | Portl | Port2 | Port3 | Port4 | Ports | Porta | PortB | PortC | PortD | PortE | Port [ Ports |

P12

@ Unused @ In © Out [JPull-up [ CMOS output - []Output 1 [] High-drive output
-P13

@ Unused @ In © Out [JPull-up [ CMOS output - []Output 1 [] High-drive output
P14

@ Unused @ In © Out [JPull-up [ CMOS output - []Output 1 [] High-drive output
P15

@ Unused @ In © Out [JPull-up [ CMOS output - []Output 1 [] High-drive output
P16

@ Unused ©h @ ©O0u@ [JPulup [CMOSoutput - []Output 1 [] High-drive output
-P17

@) Unused @ In @ Out [ Pull-up CMOS output - Output 1 High-drive output

Figure 4-17 1/O ports — Portl

ﬂ *Peripheral Functions &2 E Code Preview ﬂ Device Top View ﬂ Device List View [ Properties ﬂ FIT Configurator lﬁ;] Genel

| Porto | Portt | Port2 | Por3 | Fort4 | Ports | Porta | PortB | PortC | PortD | PortE | PortH | Fortd |

- PB0

@ Unused @ In (@ Out [ Pull-up | CMOS output v| [] Output 1 [] High-drive output
- PB1

® Unused ©hnh @ ©outd [IPul-up [CMOS output - []Output1 [ High-drive output
-PE2

@) Unused ©In @ Out [ Pull-up CMOS output - Qutput 1 High-drive output
-PB3

@ Unused ®ih® ©Ooutd []Pullup CMOS output - []Outputi  [] High-drive output
- PB4

@ Unused ©In (@ Out [ Pull-up [ Output 1 [] High-drive output
_PBS5

@ Unused @ In @ Out [ Pull-up [ Output 1 [] High-drive output
- PB6

@ Unused ©In (@ Out [ Pull-up [ Output 1 [] High-drive output
-PB7

@ Unused @ In @ Out [ Pull-up [ Output 1 [] High-drive output

Figure 4-18 1/O ports — PortB

ﬂ *Peripheral Functions 23 E Code Preview ﬂ Device Top View ﬂ Device List View [ Properties ZH FIT Cenfigurator 1@] Genel

| Portd | Port1 | Port2 | Fort3 | Forts | Forts | Portd | PortB | EortC | PortD | PertE | FortH | Portd |

@ Unused @ In @ Out [ Pull-up [ Outpust 1 [] High-drive output
-PC1

@ Unused @ In @ Out [ Pull-up [10utput1 [ High-drive output
-PC2

() Unused @ In @ Out [ Pull-up CMOS output - Output 1 High-drive output
-PC3

) Unused @ In @ Out [ Pull-up CMOS output - Output 1 High-drive output
-PC4

@ Unused @ In © Out [ Pull-up [ CMOS output -| []Output1  []High-drive output
-PCh

@ Unused @ In © Out [JPull-up [ CMOS output -| [JOutput1 [ High-drive output
- PCE

@ Unused @ In @ Out [ Pull-up | CMOS output v| [ Outpust 1 [] High-drive output
-PC7

@ Unused & In © Out [ Pull-up | CMOS output vl [ Qutput 1 [ High-drive cutput

Figure 4-19 1/O ports — PortC
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Peripheral function configuration is now complete.

Save the project using the File -> Save, then click

‘Generate Code’. The Console pane should report ‘The operation of generating file was successful’, as shown

Figure 4-20 below.

& Console 2 | & Conflicts View

Code Generator Console
The generating source folder is: C:\workspacel\CG Tutorial’

Ma4aopa2

Mad4a9aa1

Mad4a0aaa

Ma4aopaa
Ma4aoa0a ;
Ma4aopaa

Mad4a0aaa

Ma4aopaa

Mad4a0aaa

Ma4aopaa
Ma4aoa0a ;
Ma4aopaa
Ma4aoa0a ;
Ma4aopaa

Mad4a0aaa

Ma4aopaa

Mad4a0aaa

Ma4aopaa
Ma4aoa0a ;
Ma4aopaa

Mad4a0aaa

Ma4aopaa

Mad4a0aaa

Ma4aopaa
Ma4aoa0a ;
Ma4aopaa

Mad4a0aaa

Ma4aopaa

Mad4a0aaa

Ma4aopaa
Ma4aoa0a ;
Ma4aopaa

Mad4a0aaa

Ma4aopaa

Ma4a9aa35

srcheg

srchr

cg

:The following files were generated:
Me4a0aaa

main.c was generated.

rsrcheg

srehr

g

dbsct.c was generated.

srcheg

srchr

cg

intprg.c was generated.

srchcg

srehr

g

resetprg.c was generated.

srcheg

srchr

g

sbrk.c was generated.

rsrcheg

srehr

g

vecttbl.c was generated.

srcheg

srchr

g

sbrk.h was generated.

rsrcheg

srehr

cg

stacksct.h was generated.

srcheg

srchr

g

vect.h was generated.

srchcg

srehr

cg

hardware setup.c was generated.

srcheg

srchr

cg

macroedriver.h was generated.

srchcg

srehr

g

userdefine.h was generated.

srcheg

srchr

cg

cgc.c was generated.

rsrcheg

srehr

g

CEC USEer.c was gEﬂEFEtEd.

srcheg

srchr

g

cgc.h was generated.

rsrcheg

srehr

g

icu.c was generated.

srcheg

srchr

g

1CU USEer.C was generated.

srchcg

srehr

cg

icu.h was generated.

srcheg

srchr

cg

port.c was generated.

rsrcheg

srehr

cg

port user.c was generated.

srcheg

srchr

cg

port.h was generated.

rsrcheg

srehr

g

tmr.c was generated.

srcheg

srchr

g

tmr_user.c was generated.

srchcg

srehr

g

tmr.h was generated.

srcheg

srchr

g

cmt.c was generated.

rsrcheg

srehr

cg

cmt user.c was generated.

srcheg

srchr

g

cmt.h was generated.

rsrcheg

srehr

cg

sci.c was generated.

srcheg

srchr

cg

sci user.c was generated.

srchcg

srehr

g

sci.h was generated.

srcheg

srchr

cg

s12ad.c was generated.

rsrcheg

srehr

g

s512ad user.c was generated.

srcheg

srchr

g

s12ad.h was generated.

:The operation of generating file was successful.

Figure 4-20 Code generator console
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4.4 Building the Project

The project template created by Code Generator can now be built. In the Project Explorer pane expand the
‘src’ folder. The three files created by the New Project Wizard in 83.2 have been excluded from the build
automatically as part of the code generation procedure as shown in Figure 4-21. This is because the main()
function now resides in r_cg_main.c in the cg_src folder and the type definitions and setting of sections has
been handled by the Code Generator.

7 Project Explorer B3 — <,1=’=f> |
4 =% CG_Tutorial [HardwareDebuqg]
» e Includes
4 [ sec
¢ [ Cg_src

> iodefine.h
[# CG_Tutorial.c
[# dhsct.c

] typedefine.h

Figure 4-21 Files excluded from the build by Code Generator

Switch back to the ‘C/C++' perspective using the gy C/C++ button on the top right of the e® studio
workspace. Use ‘Build Project’ from the ‘Project’ menu or the %' button to build the tutorial. The project
will build with no errors.
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5.User Code Integration

In this section the remaining application code is added to the project. Source files found on the RSK Web
Installer are copied into the workspace and the user is directed to add code in the user areas of the code
generator files.

Code must be inserted in to the user code area in many files in this project, in the areas delimited by
comments as follows:

/* Start user code for _xxxxx_. Do not edit comment generated here */
/* End user code. Do not edit comment generated here */

Where _xxxx_ depends on the particular area of code, i.e. ‘function’ for insertion of user functions and
prototypes, ‘global’ for insertion of user global variable declarations, or ‘include’ for insertion of pre-processor
include directives. User code inserted inside these comment delimiters is protected from being overwritten by
Code Generator, if the user needs to subsequently change any of the Code Generator-generated code.

5.1 LCD Code Integration

API functions for the Okaya LCD display are provided with the RSK. Locate the files ascii.h , r_okaya_lcd.h,
ascii.c, and r_okaya_lcd.c on the RSK Web Installer. These files can be found in the Tutorial project for e
studio. Copy these files into the C:\Workspace\CG_Tutorial\src directory. The files will be automatically
added to the project as shown in Figure 5-1.

2 =1
3

[ Project Explorer & =

iy

4 5= CG_Tutorial [HardwareDebug]
- 44 Binaries
- [ Includes
4 |58 src
= g
- g asciic
» || ascii.h
» [n| indefine.h
» g r_okaya_lcd.c
- [n| r_okaya_lcd.h

[# © Tikarisl -
Figure 5-1 Adding files to the project

In the e’ studio Project Tree, expand the ‘src/cg_src’ folder and open the file ‘r_cg_userdefine.h’ by double-
clicking on it. Insert the following #defines in between the user code delimiter comments as shown below.

/* Start user code for function. Do not edit comment generated here */
#define TRUE (¢H)

#define FALSE ()

/* End user code. Do not edit comment generated here */

In the same folder open the file ‘'r_cg_main.c’ by double-clicking on it. Insert the following code in between the
user code delimiter comments as shown below.

/* Start user code for include. Do not edit comment generated here */
#include "r_okaya_lcd.h"
/* End user code. Do not edit comment generated here */

Scroll down to the ‘main()’ function and insert the highlighted code as shown below into the beginning of the
user code area of the main() function:
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void main(void)

{
R_MAIN_UserlInit(Q);
/* Start user code. Do not edit comment generated here */
/* Initialize the debug LCD */
R_LCD_InitQ);
/* Displays the application name on the debug LCD */
R_LCD_Display(0, (uint8_t *)' RSKRX130 ');
R_LCD_Display(1l, (uint8_t *)'" Tutorial ");
R_LCD_Display(2, (uint8_t *)" Press Any Switch ");
while (1U)
ks
/* End user code. Do not edit comment generated here */
3

5.1.1  SPICode

The Okaya LCD display is driven by the SPI Master that was configured using Code Generator in §4.3.6. In
the e studio Project Tree, open the file ‘r_cg_sci.h’ by double-clicking on it. Insert the following code in the
user code area at the end of the file:

/* Start user code for function. Do not edit comment generated here */
MD_STATUS R_SCI16_SPIMasterTransmit(uint8_t * const tx_buf, const uintl6_t tx_num);
/* End user code. Do not edit comment generated here */

Now, open the r_cg_sci_user.c file and insert the following code in the user area for global:

/* Start user code for global. Do not edit comment generated here */
/* Flag used locally to detect transmission complete */

static volatile uint8_t sci6_txdone;

/* End user code. Do not edit comment generated here */

Insert the following code in the transmitend call-back function for SCI6:

static void r_sci6_callback_transmitend(void)
/* Start user code. Do not edit comment generated here */

sci6_txdone = TRUE;
/* End user code. Do not edit comment generated here */

3
Now insert the following function in the user code area at the end of the file:

/* Start user code for adding. Do not edit comment generated here */

/

* Function Name: R_SCI6_SPIMasterTransmit

* Description : This function sends SPI6 data to slave device.
* Arguments - tx_buf -

* transfer buffer pointer

* t>©x_num -

* buffer size

* Return Value : status -

*

MD_OK or MD_ARGERROR

/
MD_STATUS R_SCI6_SPIMasterTransmit (uint8_t * const tx_buf, const uintl6_t tx_num)

MD_STATUS status = MD_OK;

/* clear the flag before initiating a new transmission */
sci6_txdone = FALSE;

/* Send the data using the APlI */
status = R_SCI6_SPI_Master_Send(tx_buf, tx_num);

/* Wait for the transmit end flag */
while (FALSE == sci6_txdone)
{
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/* Wait */
3

return (status);

NS

End of function R_SCI16_SPIMasterTransmit

/

This function uses the transmit end callback function to perform flow control on the SPI transmission to the
LCD, and is used as the main API call in the LCD code module.

5.1.2 TMR Code

The LCD code needs to insert delays to meet the timing requirements of the display module. This is achieved
using the dedicated timer which was configured using Code Generator in 84.3.3. Open the file r_cg_tmr.h and
insert the following code in the user area for function at the end of the file:

/* Start user code for function. Do not edit comment generated here */
void R_TMR_MsDelay(const uintl6_t millisec);
/* End user code. Do not edit comment generated here */

Open the file r_cg_tmr_user.c and insert the following code in the user area for global at the beginning of the
file:

/* Start user code for global. Do not edit comment generated here */

static volatile uint8_t one_ms_delay complete = FALSE;
/* End user code. Do not edit comment generated here */

Scroll down to the r_tmr_cmiaO_interrupt() function and insert the following line in the user code area:
static void r_tmr_cmiaO_interrupt(void)
/* Start user code. Do not edit comment generated here */

one_ms_delay complete = TRUE;
/* End user code. Do not edit comment generated here */

}
Then insert the following function in the user code area at the end of the file:

/* Start user code for adding. Do not edit comment generated here */

/

Function Name: R_TMR_MsDelay

Description : Uses TMRO to wait for a specified number of milliseconds
Arguments : uintlé_t millisecs, number of milliseconds to wait
Return Value : None

* % X %

void R_TMR_MsDelay (const uintl6_t millisec)
uintlé_t ms_count = O;

do
{
R_TMRO_Start();
while (FALSE == one_ms_delay_complete)

{
/* Wait */

-

R_TMRO_Stop();
one_ms_delay_complete = FALSE;
ms_count++;
} while (ms_count < millisec);
ks
/
End of function R_TMR_MsDelay
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5.2 Additional include paths

Before the project can be built the compiler needs some additional include paths added. Select the
CG_Tutorial project in the Project Explorer pane. Use the @ button in the toolbar to open the project settings.

Navigate to ‘C/C++ Build -> Settings ->Compiler -> Source and click the | button as shown in below in
Figure 5-2.

[ -
Properties for CG_Tutorial = ,@
type filter text Settings G .

> Resource — . —
Builders 4 B Compiler Include file directories &g 8 ¢ &
/ - (% Source
< i B et "S{TCINSTALLY/include”
Build Variables lT—- Jec
; &3 List
Change Toolchain Vers L% o
Dependency Scan @ Optimize
Device (28 Miscellaneous |
i)
Environment ki; User
Logging =4 CPU
Settings (&2 PIC/PID
Tool Chain Editor 4 1® Assembler Preinclude files & %
5
i C/C++ General L‘fj 50‘-_'“5
Project References (22 Object
/ (23 List
Run/Debug Settings =
. Task Repository (2 Miscellaneous
(3 User
4 B3 Linker
(2 Input
lii; List =
5 imi =% ER
v pimie Defines & w 5
BB Cartinn

Figure 5-2 Adding additional search paths

In the ‘Add directory path’ dialog, click the ‘Workspace’ button and in the ‘Folder selection’ dialog browse to the
‘CG_Tutorial/src’ folder and click ‘OK’. e studio formats the path as show in Figure 5-3 below.

=

-

Add directory path
Directory:

Sfworkspace_loc/${ProjMNamel/src}

QK Cancel

J|

] | Workspace... | [ File system...

Figure 5-3 Adding workspace search path

Repeat the above steps to add the ‘src/cg_src’ workspace search path. Select ‘Build Project’ from the ‘Project’

menu, or use the button. e studio will build the project with no errors.

The project may now be run using the debugger as described in 86. The program will display ‘RSKRX130
Tutorial Press Any Switch’ on 3 lines in the LCD display.

R20UT3450EG0100 Rev. 1.00
Nov 30, 2015

RENESAS Page 32 of 51



RSKRX130 5. User Code Integration

5.3 Switch Code Integration

API functions for user switch control are provided with the RSK. Locate the files rskrx130def.h, r_rsk_switch.h
and r_rsk_switch.c on the RSK Web Installer. These files can be found in the Tutorial project for e? studio.
Copy these files into the C:\\Workspace\CG_Tutorial\src directory. Import these three files into the project in
the same way as the Icd files.

The switch code uses interrupt code in the files r_cg_icu.h, r_cg_icu.c and r_cg_icu_user.c and timer code in
the files r_cg_cmt.h, r_cg_cmt.c and r_cg_cmt_user.c, as described in §4.3.2 and 84.3.4. It is necessary to
provide additional user code in these files to implement the switch press/release detection and de-bouncing
required by the API functions in r_rsk_switch.c.

5.3.1 Interrupt Code

In the e® studio Project Tree, expand the ‘src/cg_src’ folder and open the file ‘r_cg_icu.h’ by double-clicking on
it. Insert the following code in the user code area at the end of the file:

/* Start user code for function. Do not edit comment generated here */

/* Function prototypes for detecting and setting the edge trigger of ICU_IRQ */
uint8_t R_ICU_IRQIsFallingEdge(const uint8_t irg_no);

void R_ICU_IRQSetFallingEdge(const uint8_t irg_no, const uint8_t set_f_edge);
void R_ICU_IRQSetRisingEdge(const uint8_t irg_no, const uint8_t set_r_edge);

/* End user code. Do not edit comment generated here */

Now, open the r_cg_icu.c file and insert the following code in the user code area at the end of the file:

/* Start user code for adding. Do not edit comment generated here */

/
* Function Name: R_ICU_IRQIsFallingEdge
* Description : This function returns 1 if the specified ICU_IRQ is set to
* falling edge triggered, otherwise 0.
* Arguments : uint8_t irg_no
* Return Value : 1 if falling edge triggered, O if not
/
uint8_t R_ICU_IRQIsFallingEdge (const uint8_t irg_no)
{
uint8_t falling_edge_trig = 0x0;
if (ICU.IRQCRLirg_no]-BYTE & _04 ICU_IRQ_EDGE_FALLING)
falling_edge_trig = 1;
¥
return falling_edge_trig;
}
/
* End of function R_ICU_IRQIsFallingEdge
/
/
* Function Name: R_ICU_IRQSetFallingEdge
* Description : This function sets/clears the falling edge trigger for the
* specified ICU_IRQ.
* Arguments : uint8_t irg_no
* uint8_t set_T _edge, 1 if setting falling edge triggered, O if
* clearing
* Return Value : None
/
void R_ICU_IRQSetFallingEdge (const uint8_t irg_no, const uint8_ t set f_edge)
iT (1 == set_fT _edge)
ICU.IRQCR[irg_no].BYTE |= _04_ICU_IRQ_EDGE_FALLING;
}
else
ICU. IRQCR[irg_no]-BYTE &= (uint8_t) ~_04_ICU_IRQ_EDGE_FALLING;
}
}
R20UT3450EG0100 Rev. 1.00 RENESAS Page 33 of 51

Nov 30, 2015



RSKRX130 5. User Code Integration

/
* End of function R_ICU_IRQSetFallingEdge

Function Name: R_ICU_IRQSetRisingEdge

Description : This function sets/clear the rising edge trigger for the
specified ICU_IRQ.

Arguments  uint8_t irg_no
uint8_t set_r_edge, 1 if setting rising edge triggered, O if
clearing

Return Value : None

ook X X % X XN\

void R_ICU_IRQSetRisingEdge (const uint8_t irg_no, const uint8_t set r_edge)
if (1 == set_r_edge)
ICU. IRQCR[irg_no].BYTE |= _08_ICU_IRQ_EDGE_RISING;
}

else

ICU. IRQCR[irg_no].BYTE &= (uint8_t) ~_08_ICU_IRQ_EDGE_RISING;

N

End of function R_ICU_IRQSetRisingEdge

/* End user code. Do not edit comment generated here */

Open the r_cg_icu_user.c file and insert the following code in the user code area for include near the top of
the file:

/* Start user code for include. Do not edit comment generated here */
/* Defines switch callback functions required by interrupt handlers */
#include "r_rsk_switch.h"

/* End user code. Do not edit comment generated here */

In the same file insert the following code in the user code area inside the function r_icu_irgl_interrupt ():

/* Start user code. Do not edit comment generated here */
/* Switch 1 callback handler */

R_SWITCH_IsrCallbackl();

/* End user code. Do not edit comment generated here */

In the same file insert the following code in the user code area inside the function r_icu_irg2_interrupt ():

/* Start user code. Do not edit comment generated here */
/* Switch 2 callback handler */

R_SWITCH_IsrCallback2();

/* End user code. Do not edit comment generated here */

5.3.2 De-bounce Timer Code

Open the r_cg_cmt_user.c file and insert the following code in the user code area for include near the top of
the file:

/* Start user code for include. Do not edit comment generated here */
/* Defines switch callback functions required by interrupt handlers */
#include "r_rsk_switch.h"

/* End user code. Do not edit comment generated here */

In the same file insert the following code in the user code area inside the function r_cmt_cmiO_interrupt ():

/* Start user code. Do not edit comment generated here */
/* Stop this timer - we start it again in the de-bounce routines */
R_CMTO_Stop(Q);

/* Call the de-bounce call back routine */
R_SWITCH_DebouncelsrCal lback();
/* End user code. Do not edit comment generated here */
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In the same file insert the following code in the user code area inside the function r_cmt_cmil_interrupt ():

/* Start user code. Do not edit comment generated here */
/* Stop this timer - we start it again in the de-bounce routines */
R_CMT1_Stop(Q);

/* Call the de-bounce call back routine */
R_SWITCH_DebouncelsrCal lback();
/* End user code. Do not edit comment generated here */

5.3.3 Main Switch and ADC Code

In this part of the tutorial we add the code to act on the switch presses to activate A/D conversions and display
the result on the LCD. In 8§4.3.5 we configured the ADC to be triggered from the ADTRGO# pin, SW3. In this
code, we also perform software triggered A/D conversion from the user switches SW1 and SW2, by
reconfiguring the ADC trigger source on-the-fly once an SW1 or SW2 press is detected.

In the e® studio Project Tree open the file ‘r_cg_userdefine.h’. Insert the following code the user code area,
resulting in the code shown below

/* Start user code for function. Do not edit comment generated here */
#define TRUE (€D
#define FALSE ((®))

extern volatile uint8_t g_adc_trigger;
/* End user code. Do not edit comment generated here */

Open the file ‘'r_cg_main.c’ and insert #include "r_rsk_switch.h" in the user code area for include, resulting in
the code shown below:

/* Start user code for include. Do not edit comment generated here */
#include "r_okaya_lcd._h"

#include "r_rsk_switch.h"

/* End user code. Do not edit comment generated here */

Next add the switch module initialization function call highlighted in the user code area inside the main()
function, resulting in the code shown below:

void main(void)

{
R_MAIN_UseriInit(Q);
/* Start user code. Do not edit comment generated here */
/* Initialize the switch module */
R_SWITCH_Init(Q);
/* Initialize the debug LCD */
R_LCD_InitQ);
/* Displays the application name on the debug LCD */
R_LCD_Display(0, (uint8_t *)" RSKRX130 ");
R_LCD Display(1, (uint8_t *)" Tutorial ");
R_LCD_Display(2, (uint8_t *)" Press Any Switch ");
while (1U)
/* End user code. Do not edit comment generated here */
¥

In the same file, insert the declarations in the user code area for global, resulting in the code shown below:

/* Start user code for global. Do not edit comment generated here */

/* Prototype declaration for cb_switch_press */
static void cb_switch_press (void);

/* Prototype declaration for get _adc */
static uintl6_t get_adc(void);
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/* Prototype declaration for lcd_display_adc */
static void lcd_display_adc (const uintl6_t adc_result);

/* Variable for flagging user requested ADC conversion */
volatile uint8_t g_adc_trigger = FALSE;

/* End user code. Do not edit comment generated here */

Next add the highlighted code below in the user code area inside the main() function and the code inside the
while loop, resulting in the code shown below:

void main(void)

{
R_MAIN_UseriInit(Q);
/* Start user code. Do not edit comment generated here */
/* Initialize the switch module */
R_SWITCH_InitQ);
/* Set the call back function when SW1 or SW2 is pressed */
R_SWITCH_SetPressCal lback(cb_switch_press);
/* Initialize the debug LCD */
R_LCD_Init Q;
/* Displays the application name on the debug LCD */
R_LCD_Display(0, (uint8_t *)" RSKRX130 ');
R_LCD_Display(1, (uint8_t *)" Tutorial ');
R_LCD Display(2, (uint8_t *)" Press Any Switch ");
/* Start the A/D converter */
R_S12AD_Start();
while (1U)
{
uintl6é_t adc_result;
/* Wait for user requested A/D conversion flag to be set (SW1 or SW2) */
iT (TRUE == g_adc_trigger)
{
/* Call the function to perform an A/D conversion */
adc_result = get_adc();
/* Display the result on the LCD */
Icd_display_adc(adc_result);
/* Reset the flag */
g_adc_trigger = FALSE;
3
/* SW3 is directly wired into the ADTRGOn pin so will
cause the interrupt to fire */
else iIf (TRUE == g_adc_complete)
{
/* Get the result of the A/D conversion */
R_S12AD_Get_ValueResult(ADCHANNELO, &adc_result);
/* Display the result on the LCD */
Icd_display_adc(adc_result);
/* Reset the flag */
g_adc_complete = FALSE;
}
else
/* do nothing */
}
/* End user code. Do not edit comment generated here */
3
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Then add the definition for the switch call-back, get_adc() and Icd_display_adc() functions in the user code
area for adding at the end of the file, as shown below:

/* Start user code for adding. Do not edit comment generated here */

/
* Function Name : cb_switch_press
* Description . Switch press callback function. Sets g_adc_trigger flag.
* Argument I none
* Return value : none
/
static void cb_switch_press (void)
{
/* Check if switch 1 or 2 was pressed */
i (g_switch_flag & (SWITCHPRESS_1 | SWITCHPRESS_2))
{
/* set the flag indicating a user requested A/D conversion is required */
g_adc_trigger = TRUE;
/* Clear flag */
g_switch_flag = 0x0;
}
by
/
* End of function cb_switch_press
/
/
* Function Name : get_adc
* Description : Reads the ADC result, converts it to a string and displays
* it on the LCD panel.
* Argument I none
* Return value : uintl6_t adc value
/
static uintl6_t get_adc (void)
/* A variable to retrieve the adc result */
uintl6_t adc_result;
/* Stop the A/D converter being triggered from the pin ADTRGOn */
R_S12AD_Stop();
/* Start a conversion */
R_S12ADO_SWTriggerStart();
/* Wait for the A/D conversion to complete */
while (FALSE == g_adc_complete)
/* Wait */
}
/* Stop conversion */
R_S12ADO_SWTriggerStop(Q);
/* Clear ADC flag */
g_adc_complete = FALSE;
R_S12AD_Get_ValueResult(ADCHANNELO, &adc_result);
/* Set AD conversion start trigger source back to ADTRGOn pin */
R_S12AD_Start();
return adc_result;
by
/
* End of function get_adc
/
R20UT3450EG0100 Rev. 1.00 IQENESAS Page 37 of 51

Nov 30, 2015



RSKRX130 5. User Code Integration

Function Name : lcd_display_adc

Description : Converts adc result to a string and displays
it on the LCD panel.

Argument : uintl6_t adc result

Return value : none

o ox X XN

static void lcd_display_adc (const uintl6_t adc_result)
{

/* Declare a temporary variable */

uint8_t a;

/* Declare temporary character string */
char Icd_buffer[11] = " ADC: XXXH™;

/* Convert ADC result into a character string, and store in the local.
Casting to ensure use of correct data type. */

a = (uint8_t)((adc_result & 0x0F00) >> 8);

Icd_buffer[6] = (char)((a < 0x0A) ? (a + 0x30) : (a + 0x37));

a = (uint8_t)((adc_result & 0x00F0) >> 4);

Icd_buffer[7] = (char)((a < Ox0A) ? (a + 0x30) : (a + 0x37));

a = (uint8_t)(adc_result & 0x000F);

Icd_buffer[8] = (char)((a < 0x0A) ? (a + 0x30) : (a + 0x37));

/* Display the contents of the local string lcd_buffer */
R_LCD_Display(3, (uint8_t *)lcd_buffer);

* NS

End of function lcd_display_adc

/* End user code. Do not edit comment generated here */

Open the file ‘r_cg_s12ad.h’ by double-clicking on it. Insert the following code in the user code area for
function, resulting in the code shown below:

/* Start user code for function. Do not edit comment generated here */

/* Flag indicates when A/D conversion is complete */
extern volatile uint8_t g_adc_complete;

/* Functions for starting and stopping software triggered A/D conversion */
void R_S12ADO_SWTriggerStart(void);
void R_S12AD0O_SWTriggerStop(void);

/* End user code. Do not edit comment generated here */

Open the file ‘r_cg_s12ad.c’ by double-clicking on it. Insert the following code in the user code area for
adding at the end of the file, as shown below:

/* Start user code for adding. Do not edit comment generated here */

Function Name: R_S12ADO_SWTriggerStart

Description : This function starts the ADO converter.
Arguments : None

Return Value : None

O X XN

void R_S12ADO_SWTriggerStart(void)

IR(S12AD, S12ADIO) = OU;
IEN(S12AD, S12ADI0) = 1U;

S12AD.ADCSR.BIT.ADST = 1U;
3

/
End of function R_S12AD0O_SWTriggerStart

Function Name: R_S12ADO_SWTriggerStop

Description : This function stops the ADO converter.
Arguments : None

Return Value : None

XX RN

void R_S12ADO_SWTriggerStop(void)
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S12AD.ADCSR.BIT.ADST = 0U;

IEN(S12AD, S12ADIO) = OU;
IR(S12AD, S12ADI0) = OU;
3
/
End of function R_S12ADO_SWTriggerStop

/* End user code. Do not edit comment generated here */

Open the file r_cg_sl2ad user.c and insert the following code in the area for global, resulting in the code
shown below:

/* Start user code for global. Do not edit comment generated here */
/* Flag indicates when A/D conversion is complete */

volatile uint8_t g_adc_complete;

/* End user code. Do not edit comment generated here */

Insert the following code in the user code area of the r_s12ad_interrupt() function, resulting in the code shown
below:

static void r_sl2ad_interrupt(void)

/* Start user code. Do not edit comment generated here */
g_adc_complete = TRUE;
/* End user code. Do not edit comment generated here */

}

Select ‘Build Project’ from the ‘Project’ menu, or use the button. e” studio will build the project with no
errors.

The project may now be run using the debugger as described in 86. When any switch is pressed, the
program will perform an A/D conversion of the voltage level on the ADPOT line and display the result on the
LCD panel. Return to this point in the Tutorial to add the UART user code.
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5.4 Debug Code Integration

API functions for trace debugging via the RSK serial port are provided with the RSK. Locate the files
r rsk_debug.h and r_rsk debug.c on the RSK Web Installer. These files can be found in the
RSKRX130_Tutorial project for e” studio. Copy these files into the C:\Workspace\CG_Tutorial\src directory.
Import these two files into the project in the same way as the LCD files.

In the r_rsk_debug.h file, ensure the following macro definition is included:

/* Macro for definition of serial debug transmit function - user edits this */
#define SERIAL_DEBUG_WRITE (R_SCI1_AsyncTransmit)

This macro is referenced in the r_rsk_debug.c file and allows easy re-direction of debug output if a different
debug interface is used.

5.5 UART Code Integration

55.1 SCI Code

In the e studio Project Tree, expand the ‘src/cg_src’ folder and open the file ‘r_cg_sci.h’ by double-clicking on
it. Insert the following code in the user code area at the end of the file:

/* Start user code for function. Do not edit comment generated here */

/* Exported functions used to transmit a number of bytes and wait for completion */

MD_STATUS R_SCI6_SPIMasterTransmit(uint8_t * const tx_buf, const uintl6_t tx_num);

MD_STATUS R_SCI1_AsyncTransmit(uint8_t * const tx_buf, const uintl6_t tx_num);

/* Character is used to receive key presses from PC terminal */
extern uint8_t g_rx_char;

/* Flag used to control transmission to PC terminal */
extern volatile uint8_t g_tx_flag;

/* End user code. Do not edit comment generated here */

Open the file ‘r_cg_sci_user.c. Insert the following code in the user area for global near the beginning of the
file:

/* Start user code for global. Do not edit comment generated here */

/* Global used to receive a character from the PC terminal */
uint8_t g_rx_char;

/* Flag used to control transmission to PC terminal */
volatile uint8_t g_tx_flag = FALSE;

/* Flag used locally to detect transmission complete */
static volatile uint8_t sci6_txdone;
static volatile uint8_t scil_txdone;

/* End user code. Do not edit comment generated here */

In the same file, insert the following code in the user code area inside the r_scil_callback_transmitend()
function:

static void r_scil_callback_transmitend(void)

{
/* Start user code. Do not edit comment generated here */
scil_txdone = TRUE;
/* End user code. Do not edit comment generated here */
¥
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In the same file, insert the following code in the user code area inside the r_scil_callback_receiveend()
function:

static void r_scil_callback_receiveend(void)

{

}

/* Start user code. Do not edit comment generated here */

/* Check the contents of g_rx char */
if (("c” == g_rx_char) || (C" == g_rx_char))
{

g_adc_trigger = TRUE;
by

/* Set up SCI1 receive buffer and callback function again */
R_SC11_Serial_Receive((uint8_t *)&g_rx_char, 1);

/* End user code. Do not edit comment generated here */

At the end of the file, in the user code area for adding, add the following function definition:

o X Ok X Ok X XN\

MD_OK or MD_ARGERROR

Function Name: R_SCI1_AsyncTransmit
Description : This function sends SCI1 data and waits for the transmit end flag.
Arguments - tx_buf -
transfer buffer pointer
t>x_num -
buffer size
Return Value : status -

MD_STATUS R_SCI1_AsyncTransmit (uint8_t * const tx_buf, const uintl6_t tx_num)

}
/

MD_STATUS status = MD_OK;

/* clear the flag before initiating a new transmission */
scil_txdone = FALSE;

/* Send the data using the APlI */
status = R_SCI1_Serial_Send(tx_buf, tx_num);

/* Wait for the transmit end flag */
while (FALSE == scil_txdone)

/* Wait */

return (status);

/

* End of function R_SCI1_AsyncTransmit

/* End user code. Do not edit comment generated here */
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55.2 Main UART code

Open the file ‘r_cg_main.c’. Add the following declaration to the user code area for include near the top of the
file:

#include "r_rsk_debug.h"

Add the following declaration to the user code area for global near the top of the file:

/* Prototype declaration for uart_display_adc */
static void uart_display adc(const uint8_t adc_count, const uintl6_t adc_result);

/* Variable to store the A/D conversion count for user display */
static uint8_t adc_count = 0;

Add the following highlighted code to the user code area in the main function:

void main(void)

R_MAIN_UseriInit(Q);
/* Start user code. Do not edit comment generated here */

/* Initialize the switch module */
R_SWITCH_InitQ;

/* Set the call back function when SW1 or SW2 is pressed */
R_SWITCH_SetPressCallback(cb_switch_press);

/* Initialize the debug LCD */
R_LCD_Init Q;

/* Displays the application name on the debug LCD */
R_LCD Display(0, (uint8_t *)'" RSKRX130 ");

R_LCD Display(1, (uint8_t *)" Tutorial ");

R_LCD Display(2, (uint8_t *)" Press Any Switch ");

/* Start the A/D converter */
R_S12AD_Start();

/* Set up SCI1 receive buffer and callback function */
R_SC11_Serial_Receive((uint8_t *)&g_rx_char, 1);

/* Enable SCI1 operations */
R_SCI1_Start();

while (1U)
{
uintl6é_t adc_result;

/* Wait for user requested A/D conversion flag to be set */
if (TRUE == g_adc_trigger)
{
/* Call the function to perform an A/D conversion */
adc_result = get_adc();

/* Display the result on the LCD */
Icd_display_adc(adc_result);

/* Increment the adc_count */
if (16 == ++adc_count)
{

3

/* Send the result to the UART */
uart_display_adc(adc_count, adc_result);

adc_count = 0;

/* Reset the flag */
g_adc_trigger = FALSE;
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/* SW3 is directly wired into the ADTRGOn pin so will
cause the interrupt to fire */
else if (TRUE == g_adc_complete)
{
/* Get the result of the A/D conversion */
R_S12AD_Get_ValueResult(ADCHANNELO, &adc_result);

/* Display the result on the LCD */
Icd_display_adc(adc_result);

/* Increment the adc_count */
if (16 == ++adc_count)
{

3

/* Send the result to the UART */
uart_display_adc(adc_count, adc_result);

adc_count = 0;

/* Reset the flag */
g_adc_complete = FALSE;
}

else

/* do nothing */
}

/* End user code. Do not edit comment generated here */

}

Then, add the following function definition in the user code area at the end of the file:

/

* Function Name : uart_display_adc

* Description : Converts adc result to a string and sends it to the UARTL.
* Argument : uint8_t : adc_count

* uintl6é_t: adc result

* Return value : none

/
static void uart_display_adc (const uint8_t adc_count, const uintl6_t adc_result)
{

/* Declare a temporary variable */

char a;

/* Declare temporary character string */
static char uart_buffer[] = "ADC xH Value: xxxH\r\n';

/* Convert ADC result into a character string, and store in the local.
Casting to ensure use of correct data type. */

a = (char)(adc_count & 0x000F);

uart_buffer[4] = (char)((a < Ox0A) ? (a + 0x30) : (a + 0x37));

a = (char)((adc_result & 0OxOF00) >> 8);

uart_buffer[14] = (char)((a < 0x0A) ? (a + 0x30) : (a + 0x37));

a = (char)((adc_result & O0x00F0) >> 4);

uart_buffer[15] = (char)((a < 0x0A) ? (a + 0x30) : (a + 0x37));

a = (char)(adc_result & 0x000F);

uart_buffer[16] = (char)((a < 0x0A) ? (a + 0x30) : (a + 0x37));

/* Send the string to the UART */
R_DEBUG_Print(uart_buffer);

}

/
* End of function uart_display_adc

/

Select ‘Build Project’ from the ‘Build’ menu. e studio will build the project with no errors.
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The project may now be run using the debugger as described in 86. Connect the RSK G1CUSBO port to a
USB port on a PC. If this is the first time the RSK has been connected to the PC then a device driver will be
installed automatically. Open Device Manager, the virtual COM port will now appear under 'Port (COM & LPT)'
as 'RSK USB Serial Port (COMXx)', where x is a number.

Open a terminal program, such as HyperTerminal, on the PC with the same settings as for SCI1 (see §4.3.6).
When any switch is pressed, or when ‘c’ is sent via the COM port, the program will perform an A/D conversion
of the voltage level on the ADPOT line and display the result on the LCD panel and send the result to the PC
terminal program via the SCI1. Return to this point in the Tutorial to add the LED user code.

5.6 LED Code Integration

Open the file ‘r_cg_main.c’. Add the following declaration to the user code area for include near the top of the
file:

#include "'rskrx130def.h"

Add the following declaration to the user code area for global near the top of the file:

/* Prototype declaration for led_display_count */
static void led_display_count(const uint8_t count);

Add the following highlighted code to the user code area in the main function:

void main(void)

{
R_MAIN_UseriInit(Q);
/* Start user code. Do not edit comment generated here */
/* Initialize the switch module */
R_SWITCH_Init();
/* Set the call back function when SW1 or SW2 is pressed */
R_SWITCH_SetPressCallback(cb_switch_press);
/* Initialize the debug LCD */
R_LCD_Init Q;
/* Displays the application name on the debug LCD */
R_LCD Display(0, (uint8_t *)'" RSKRX130 ");
R_LCD Display(1, (uint8_t *)" Tutorial ");
R_LCD Display(2, (uint8_t *)" Press Any Switch ");
/* Start the A/D converter */
R_S12AD_Start();
/* Set up SCI1 receive buffer and callback function */
R_SCI11_Serial_Receive((uint8_t *)&g_rx_char, 1);
/* Enable SCI1 operations */
R_SCI1_Start();
while (1U)
{
uintlé_t adc_result;
/* Wait for user requested A/D conversion flag to be set(SW1 or Sw2) */
if (TRUE == g_adc_trigger)
{
/* Call the function to perform an A/D conversion */
adc_result = get_adc();
/* Display the result on the LCD */
Icd_display_adc(adc_result);
/* Increment the adc_count and display using the LEDs */
if (16 == ++adc_count)
{
adc_count = 0;
3
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led_display_count(adc_count);

/* Send the result to the UART */
uart_display_adc(adc_count, adc_result);

/* Reset the flag */
g_adc_trigger = FALSE;

by
/* SW3 is directly wired into the ADTRGOn pin so will

cause the interrupt to fire */
else if (TRUE == g_adc_complete)

{

/* Get the result of the A/D conversion */

R_S12AD_Get_ValueResult(ADCHANNELO, &adc_result);

/* Display the result on the LCD */
Icd_display_adc(adc_result);

/* Increment the adc_count and display using the LEDs */

if (16 == ++adc_count)
{

adc_count = 0;

led_display_count(adc_count);

/* Send the result to the UART */
uart_display_adc(adc_count, adc_result);

/* Reset the flag */
g_adc_complete = FALSE;

}

else

{
}

/* do nothing */

}

/* End user code. Do not edit comment generated here */

}

Then, add the following function definition in the user code area at the end of the file:

/

* Function Name : led_display_count

* Description : Converts count to binary and displays on 4 LEDSO-3
* Argument : uint8_t count

* Return value : none

static void led_display_count (const uint8_t count)

/* Set LEDs according to lower nibble of Count parameter */

LEDO = (uint8_t) ((count & 0x01)
LED1 = (uint8_t) ((count & 0x02)
LED2 = (uint8_t) ((count & 0x04)
LED3 = (uint8_t) ((count & 0x08)

?

RN

LED_ON : LED_OFF);
LED_ON : LED_OFF);
LED_ON : LED_OFF);
LED_ON : LED_OFF);

N

End of function led_display count

/* End user code. Do not edit comment generated here */

Select ‘Build Project’ from the ‘Build’ menu, or press F7. e studio will build the project with no errors.

The project may now be run using the debugger as described in 86. The code will perform the same but now
the LEDs will display the adc_count in binary form.

R20UT3450EG0100 Rev. 1.00
Nov 30, 2015

RENESAS

Page 45 of 51



RSKRX130 6. Debugging the Project

6.Debugging the Project

In the Project Explorer pane, ensure that the ‘CG_Tutorial’ project is selected. To debug the project, click the
5 button. The dialog shown in Figure 6-1 will be displayed.

Confirm Perspective Switch @

This kind of launch is configured to open the Debug perspective when it suspends.

This Debug perspective is designed to support application debugging. It
incorporates views for displaying the debug stack, variables and breakpoint
management.

Do you want to open this perspective now?

[ Rermember my decisicn

| Yes | [ Mo

Figure 6-1 Perspective Switch Dialog

Click ‘OK’ to confirm that the debug window perspective will be used. The debugger will start up and the code
will stop at the Code Generator function ‘PowerOn_Reset’ as shown in Figure 6-2.

Debug - CG_Tuterial/src/cg_src/r_cg_resetprg.c - e2 studic
File Edit Source Refactor Mavigate Search Project Run  Window Help
T @SRRI BN OB NH A OINIB-0-Q

%5 Debug 52 L PSH|id| e =8 ®Vai
4 [ CG_Tutorial HardwareDebug [Renesas GDB Hardware Debugging]
4 1% CG_Tutorialx[1]
4 o Thread [1]1 (single core) (Suspended : Signal : SIGINT:Interrupt)
= PowerON_Reset(] at r_cg_resetprg.c:66 Oxfffe0000
»| gdb
p| GDB server

MName

[ r_cg_resetprg.c &2
5 fffeceoe void PowerON_Reset(void)

{
fffepoee set_intb(_ sectop("CEVECT"));
fffeeol7 _INITSCT(); /* Initialize Sections */
fffeeelb HardwareSetup(); /* Use Hardware Setup */
fffeaalf nop();
fffedB2s set_psw(PSW_init); /* set Ubit & Ibit for PSW */
fffees2s main();
fffedB2c brk();

Start user code for adding. Do not edit comment generated here */
78 /* End user cede. Do not edit comment generated here */

4

&l Console 52 | 4% Tasks = Renesas Coverage Memory Usage (- - Performance Analysis (20 Profile EZReal—time Chi

CG_Tutorial HardwareDebug [Renesas GDB Hardware Debugging] gdb
Figure 6-2 Debugger start up screen

For more information on the e” studio debugger refer to the Tutorial manual. To run the code click the (B
button. The debugger will stop again at the beginning of the main() function. Press B again to run the code.
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7.Additional Information

Technical Support

For details on how to use e studio, refer to

the help file by opening e® studio, then Windaw [Help |
selecting Help > Help Contents from the

menu bar. & v @ i@ Welcome
{7} Help Contents
B Search
Dynamic Help

For information about the RX130 group microcontroller refer to the RX130 Group Hardware Manual.

For information about the RX assembly language, refer to the RX Family Software Manual.
Technical Contact Details
Please refer to the contact details listed in section 9 of the “Quick Start Guide”

General information on Renesas microcontrollers can be found on the Renesas website at:
http://www.renesas.com/

Trademarks

All brand or product names used in this manual are trademarks or registered trademarks of their respective

companies or organisations.

Copyright

This document may be, wholly or partially, subject to change without notice. All rights reserved. Duplication of
this document, either in whole or part is prohibited without the written permission of Renesas Electronics

Europe Limited.

© 2015 Renesas Electronics Europe Limited. All rights reserved.
© 2015 Renesas Electronics Corporation. All rights reserved.
© 2015 Renesas System Design Co., Ltd. All rights reserved.
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